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Terms of Use 

Information in this document is subject to change without notice and does not represent 

a commitment on the part of SeQent. The software, which includes information 
contained in any databases, described in this document is furnished under a license 
agreement or nondisclosure agreement and may be used or copied only in accordance 
with the terms of the agreement. It is against the law to copy the software on any 
medium except as specifically allowed in the license or nondisclosure agreement. No 
part of this manual may be reproduced or transmitted in any form or by any means, 

electronic or mechanical, including photocopying and recording, for any purpose without 
the express written permission of SeQent. 

This software program and associated documentation are provided in an “as is” 
condition. In no event shall SeQent, its employees, directors or agents be liable for any 
loss or damage whatsoever (including, but not limited to, damages for loss of business 

profits, business interruption, loss of business information, or other monetary loss) 

arising out of the use of or the inability to use this software. By installing this software 
on your computer system you acknowledge that you have read and understood these 
terms and that you accept them. 

© 2012 SeQent All rights reserved.  

Printed in Canada 

Marquee Manager Video Server is a trademark of SeQent. Other brand and product names are 
trademarks, or registered trademarks, of their respective holders. 
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Version Information 

Edits 

Version Date Author Description 

V9.00 January 2010 K. MacLennan Initial Document 

V9.01 March 2011 K. MacLennan Enhancements 

V9.02 Sept 2012 D. Labute Updates to include recently 

added features 
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Customer Service 

Support Contracts 

You may purchase a support contract for any of our products. Support is free for 
product trials and for the first 30 days of product ownership. 

To view the SeQent support options, go to our web site (www.SeQent.com). To contact 
SeQent’s Customer Support department please use the following methods. 

Urgent Issues: 

Normal Business Hours (Weekdays 9AM-5PM EST): 

1. Dial: +1.519.652.0401 

2. Select: Option 1 

If there is no answer then please leave a voice mail message with your contact 

information and your call will be returned promptly. 

After Hours (Weekdays 5PM-9AM EST and Weekends): 

1. Dial: +1.519.652.0401 

2. Select: Option 1 

3. Listen to the on-call phone number provided 

4. Call the indicated after hours number 

If there is no answer then please leave a voice mail message with your contact 

information and your call will be returned promptly. 

Non-Urgent Issues / Questions 

Normal Business Hours (Weekdays 9AM-5PM EST): 

1. E-Mail: Support@SeQent.Com 

2. Include the following information: 
- Contact Information 
- Product Name  

- Version 
- Description of the problem being experienced 

Location 

Corporate Office  
 
4500 Blakie Road, Suite 137 
London, Ontario  
Canada  
N6L 1G5 

Phone : +1.519.652.0401  
Fax : +1.519.652.9275 
Email: info@SeQent.com 

mailto:info@SeQent.com
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.1. Product Overview 

SeQent’s Marquee Manager Video Server provides network connection for commodity 
video display devices.  It allows you to connect standard LCD/Plasma monitors and video 
projectors to any TCP/IP network. The video server TCP/IP enables any standard display 
device, providing both network connectivity and display formatting. By providing marquee-

like formatting capabilities, standard VGA based video displays can be used as small 
screen marquees. With the small format and standard based interfaces, the Video Server 
based solution facilitates machine or station level Andon at a very low cost. 
 
 

 

 

Key Features: 

o Efficient network protocol – no video streaming 

o Small physical size 

o No operating system or virus protection to maintain 

o No moving parts 

o Remote management 

o Easy to use Windows interface for template definition 

o 4:3 and 16:9 aspect ratios 

o Supports video splitting 
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How it Works 

The Video Server works with a wide variety of displays, transforming them into marquees.  
It also allows any standard Marquee Manager installation to incorporate any video driven 
device (LCD, Projector) into the network.  This allows utilization of all the capabilities 
available in Marquee Manager with no changes to the gateways or servers. 

The Emulator software must be run on every display.  The Emulator receives all data that 
has been configured in the Configuration Editor then sends this data to the displays.  

The Configuration Editor, included with the Emulator software, enables the user to 

configure the displays using various tools for each available marquee type.  The user can 
edit such things as borders, colors, and size of the objects, basically providing a visual of 
exactly how the data will be displayed by the Emulator. 
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.2. Installation 

Prerequisites  

Before beginning the installation, it is important to determine the hardware and 

software requirements necessary for Marquee Manager Video Server to run efficiently. 
Review the following prerequisite list before the software is installed. 

Licensing  General: Per server  

System Requirements 

 
 
One of: 

Microsoft Win2K3 (SP1+) 
Microsoft WinXP (SP1a+) 
Microsoft Win2K8 
MicrosoftWin2K8R2 
Microsoft Win7 
Microsoft Win7-64 

Display: 800x600  

Disk Space: 200MB 
RAM: 128MB 

Applications: 
Marquee Manager Server 

Windows compatible workstation (configuration 
software) 

VGA, DVI or HDMI compatible video display 
device 

Fixed TCP/IP address 

 

 

Drivers 
TCP/IP 
MDAC V2.7 (SP1+)  
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Installing the Application 

Before installing Marquee Manager Video Server, the following information must be 

considered: 

o Determine which disk drive/directory your video server software will reside on. The 
server software itself requires 120 MB of disk space for installation and operation. 

o Determine the marquees that will be used for displaying messages as well as the 

correct address configured for each. 

 

To Install Marquee Manager Video Server: 

1. Run Video Server SETUP.EXE. Click Next. 

 

 

2. You will be prompted for the installation destination directory. 

 

 

3. Click Finish to complete the installation. The computer must be restarted before the 
Marquee Manager Video Server can be configured or operated.  
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.3. Configuration 

Setting up the Application 

Before you can begin using the Video Server, you must add at least one template to the 
Video Server Configuration Editor. Once the template is added, various settings that 
control the interface to the template must be configured. The steps required include:  

o Adding a New Project 

o Adding a Template 

o Adding a Server 
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Configuring Key Components – New Project 

Adding a Project 

Marquee Manager Video Server Configuration Editor allows you to configure multiple 
projects that include multiple templates.   

New Project Steps 

1. After installing and restarting your computer, select Start – Programs – Marquee 
Manager – Video Server to launch the Video Server Configuration Editor. 

2. Select Project set up/change the attributes for the project.  The following screen is 
displayed: 
 

 
  

 PROJECT SETTINGS 

Project Details 

Name A unique name to reference the Project.  Default is Project 

FilePath The location where the project will be saved. 

Settings – Board 

AspectRatio Video properties that best match the display being used.  (See 
Table 1.0 Aspect Ratios below for a list of the available aspect 
ratios) 

Size Dimensions of the display being used, in pixels. This setting is 
only used when using the custom aspect ratio setting. 

AdminPort Port that the Configuration Editor uses to push the .xml file to 
the Emulator.  Default is 2001. 

DataPort Port that is used by Marquee Manager Server to send the data to 
the displays.  Default is 2002. 

AuxPort Optional port that is used by Marquee Manager Server to send 
background color tokens to the displays, overriding the 

background color of the canvas and all objects.  Default is 0 
(Disabled). 



Configuration 

 

FontName Default font that will be used for all objects in the project unless 

overridden at a lower level. 

Settings – Controller 

Controller The name of the Controller that will be used to display various 

templates in a cycle defined by the administrator or by 

gateway events. 

Address Each manufacturer will have a different address format. For 
format examples, see “Appendix A - Manufacturers Address 
Formats”.  This address must match what has been 
configured for the Controller type Marquee in Marquee 

Manager Administrator.  (See Chapter 4 in this manual for 
details on adding/configuring various marquee types.) 

ScrollSpeed Controls the scrolling speed of data for each speed:  Slow, 
Medium and Fast 

FlashRate Controls the flashing speed of data. Defaults to 30:45 ms 

Heartbeat The time delay for how often the Emulator expects to see data.  
If no data is being received in x sec., it will close the connection 
to Marquee Manager Server and display the CommError.  Default 
Heartbeat is set to 10 sec. 

CommError The error message that will appear when the Emulator loses 
connection with Marquee Manager Server.  Insertion tags may be 
used in this message.  See “Appendix B – Insertion Tags” for a 
list of available tags that may be included in this text. The text 

defined here will be automatically scaled to fit 96% of the width 
of the screen. 

Settings – Special Characters 

CHRVB Width in pixels of a special separation character that can be 
inserted into messages by using <CHR-VB>. Default 3 pixels, 
maximum 999. 

Settings – Tunes 

TuneAddress Each manufacturer will have a different address format. For format 
examples, see “Appendix A - Manufacturers Address Formats”.  
This address must match what has been configured for the 
Sounder type Marquee in Marquee Manager Administrator.  (See 
Chapter 4 in this manual for details on adding/configuring various 
marquee types.) 

 

NAME RESOLUTION ASPECT RATIO 

VGA 640 by 480 4:3 
SVGA 800 by 600 4:3 (12:9) 
XGA 1024 by 768 4:3 
XGA+ 1152 by 864 4:3 
 1280 by 600 W_2, 133:1 (32:15) 
HD Ready 1280 by 720 16:9 
WXGA 1280 by 768 5:3 (15:9) 
WXGA 1280 by 800 8:5 (16:10) 
SXGA (UVGA) 1280 by 960 4:3 
SXGA 1280 by 1024 5:4 
 1400 by 1050  
WXSGA 1440 by 900 8:5 (16:10) 
HD+ 1600 by 900 16:9 
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UXGA 1600 by 1200 4:3 
 1856 by 1392 4:3 
HD-1080 1920 by 1080 16:9 
WUXGA 1920 by 1200 8:5 
 1920 by 1440 4:3 
QXGA 2048 by 1536 4:3 
Custom User Defined (Pixel Based) User Defined 

Table 1.0 – Aspect Ratios 

3. From the File menu, select Save Project once the project details have been 
configured. 
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Configuring Key Components - Template 

Adding a Template 

Marquee Manager Video Server includes a template switching feature that permits for a 
single display to present data for many different functions.  Template switching may be 
timed or controlled via external conditions.  Because it contains no moving parts and 

proprietary firmware, the video server does not require OS service packs or virus 
scanning. 

Templates support the following object types: counters (variable length), 
clocks (12/24 hour), multi-line text marquees, cell text, cell block and http/url displays 
(full or partial screen). 

 

New Template Steps 

1. After installing and restarting your computer, select Start – Programs – Marquee 
Manager – Video Server to launch the Video Server Configuration Editor. 

2. Select the Templates folder in the tree view. Click the New icon in the toolbar then 

select Template from the menu options. 

 
 

 
  

There must always be a default template.  When a new configuration project is started, the 
first template will automatically be started and will be assigned as the default. 

MISC  

Templates 

Name A unique name to reference the template.  Default is Template1 

Description Any text the administrator wishes to refer to the template. This 
field is optional 

Locked Prevents positional movement of objects on the template. Used 
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to freeze a layout once everything is in its proper location. 

FontName Default font that will be used for all objects on this template 
unless overridden at a lower level. 

ID This field is already populated with a unique ID. 

3. After completing the Misc Details, you can now configure the template and add 
multiple object types to display data. 

4. On the right of the configuration screen is a tools section that contains all the 
available objects that may be utilized to configure each template.  Select one of 
these objects and drag it onto the template area.  Resizing arrows will appear,   
allowing you to resize the object to the desired size. (See table 1.1 Available Tools 
below for a list and description of the tools that can be added to each template) 

5. From the Tools menu select the View Grid option to make object 
placement/organization easier in relation to other objects that will be added.  The 
Snap to Grid option is available when the View Grid option is turned on.  The user 

can utilize the grid when aligning the objects, ‘snapping’ the object to the grid 
before resizing them. 

6. The arrow keys can be used to move the object to the desired location on the grid. 

7. Use Ctrl and the arrow keys to move the object around the grid.  Use Shift and the 
arrows keys to resize the object. 

See next section entitled “View Menu Options” for additional options on viewing the tool 
objects.
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OBJECT PROPERTIES 

Common 

Name A unique name to reference the tool.  Defaults to Tool# but this 
may be edited. 

Address A unique address given to the object. This must match what is 
configured in Marquee Manager Administrator for that marquee. 

ToolType Displays the type of tool that is currently selected. 

Location Location of the object’s starting point for the object boundary 

(in pixels) from the top and left. 

Size Length and height of the object boundary (in pixels). 

BorderWidth Select the width of the border you wish to add around the tool.  
The Configuration Editor uses a measurement of ‘unit’ that is 
relative to the template size and resolution of the display.  The 

smaller the number, the thinner the border. 

BorderColor Select the color you wish to add to the border, using the format 

<COL-XXX>  ex.  To show a red border, type <COL-RED> in 
the BorderColor field for that tool.  See “Appendix B – Insertion 
Tags” for a list of available color tags that are available. 

Description Any text the administrator wishes to refer to the template. This 
field is optional 

FontName Font that will be used when displaying text on this object. 

ADDITIONAL  

Solid Cell and Text Cell 

CellRow Number of rows for cell displays 

CellCol Number of columns for cell displays 

CellBorderWidth Select the width of the border you wish to add around the tool.  
The Configuration Editor uses a measurement of ‘unit’ that is 

relative to the template size and resolution of the display.  The 

smaller the number, the thinner the border. 

CellBorderColor Select the color you wish to add to the cell border, using the 
format <COL-XXX>  ex.  To show a red border, type <COL-
RED> in the CellBorderColor field for that tool.  See “Appendix 
B – Insertion Tags” for a list of available color tags that are 
available. 

Clock 

Justification Left, center or right justifies the clock time according to the size 
the clock object is made. 

ShowAMPM  Option to have ‘AM’ or ‘PM’ displayed with the clock time. 

Text and Label 

LineCount  Defines the number of lines for the objects.  This must match 
what is configured on the Options tab in Marquee Manager 
Administrator in the ‘Number of Lines’ and ‘Sign Height’ fields. 

Text 

ScrollingDirection Defines the direction of text scrolling for the object. Scrolling can 
either be traditional right to left, or vertical. Default is Horizontal. 

Label 

Text Allows the addition of token in addition to text to define the Label 
object.  Ie.  <COL-RED><MOD-FL>Target displays the word 
Target with attributes of Color red, and Mode of flashing. 

Display Text Shows the text that will be displayed on the Label object. 
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Web 

CacheURL Option to cache the web page so that if the same URL is passed, it 

does not reload the page but returns you to where you left off, 
even when returning from a series of template switches. 

String Alert 

CacheURL Option to cache the web page so that if the same URL is passed, it 

does not reload the page but returns you to where you left off, 
even when returning from a series of template switches. 

Timer 

CellBorderWidth Select the width of the border you wish to add around the 

tool.  The Configuration Editor uses a measurement of 

‘unit’ that is relative to the template size and resolution of 

the display.  The smaller the number, the thinner the 

border. 

CellBorderColor Select the color you wish to add to the cell border, using 

the format <COL-XXX>  ex.  To show a red border, type 

<COL-RED> in the CellBorderColor field for that tool.  See 

“Appendix B – Insertion Tags” for a list of available color 

tags that are available. 

TextPosition Select the position of the text label relative to the timer 

portion of the object. For detail on how to use this object, 

please reference Appendix C. 
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8. Continue in this manner, selecting the tools that will become part of the template.   

9. Click the Save icon in the toolbar to save the new template. 

10. After completing the template setup, you can now add multiple servers which will 
utilize the templates assigned to them. 

 
 
Sample New Video Server Template Set-up 
 

  

Sample New Video Server Template as seen from the VideoServer Emulator 
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Tool Description 
Clock A display element specifically designed to display the 

time of day. The time may be displayed in either 12 or 24 
hour format and will display “AM” or “PM”. 

Solid Cell Cell type displays typically used to display data best 
represented in a grid format. 

Counter A display element specifically designed to display numeric 
counts. The counts may be positive or negative. 

Web Used to display web objects on a Video Server display.  It 
may be used to show multiple URLs on a Video Server 
and can be mixed with regular Andon/Marquee objects.   

Text Used to display text on a marquee, providing the means 
to display time, date and message text such as 
production counts, and what areas of a plant are 
experiencing problems.  

Text Cell Used to display data best represented in a grid format 
which contains text cells that may be configured with up 

to three characters for display 

Label Name assigned to a Tool to define/describe the date 
being displayed. 

Application Allows another application to be launched and displayed 

on the VideoServer.  This will be the path/location of the 
application’s executable that you wish to run. 

Table 1.1 – Available Tools
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View Menu Options 

The Video Server’s Configuration Editor has additional options that may be useful when 

adding objects to create templates.  These options are available in the View menu at 
the top of the screen.   

 

Using the View Menu 

1. Click on View in the toolbar.  The following options are available:  Tool Type, 
Address, Content and Name. 

VIEW OPTIONS 

Tool Type Allows the user to view the type of object that has been added 
to the template.  ie.  Clock, Solid Cell, Counter, Web, Text, Text 

Cell or Label) 

Address Allows the user to view the address that was assigned to the 
object.   

Content Allows the user to view the number of characters that the object 

allows to ensure the object is the correct size for the desired 
number of characters. 

Name Allows the user to view the name that has been assigned to the 
object. 

  

2. The default viewing option is Name. 
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Configuring Key Components - Server 

Adding a Server 

Marquee Manager Video Server allows templates to be assigned to multiple servers, 
reducing the need to configure templates on each video server implemented. 

 

New Server Steps 

1. Select the Servers folder in the tree view. Click the New icon in the toolbar then 
select Server from the menu options. 

 

MISC  

Server 

Name A name to reference the server. 

Host The TCP/IP name or address of the Video Server 

Port Defaults to 2001 

Subscribe Instead of uploading the configuration to a server, if this option 

is set to YES, a UNC name can be specified to copy the 
configuration file to instead. 

Path UNC path to copy the configuration file to. Only used if the 

Subscribe property is set to YES. 

Description Any text the administrator wishes to refer to the server. This 
field is optional 

 

2. After completing the Misc Details, you can now assign a template to that server via 
Marquee Manager Administrator. 

3. From the File menu in the toolbar, select Update Servers to send all new templates, 

servers and any updates to the Video Servers.   



Configuration 

Page 25 of 38 

 

 



c h a p t e r  4 – u s i n g  t h e  v i d e o  s e r v e r 

Page 26 of 38 

 

.4. Using Marquee Manager Video Server 

Once the Video Server Configuration Editor has been set up, Marquee Manager 

Administrator must be configured to reflect the marquees/displays in the editor. 

Configuring Marquee Manager Administrator 

Before configuring the marquees that have been configured in the Configuration Editor, 
a new Device must be added via Marquee Manager Administrator.  This Device will be 
the details for the Video Server.   

Adding a New Device 

1. In the tree view, click on the Device folder and then click on the New icon in the 

toolbar. A Details tab will appear. 
 

 

2. Under the Communications section of the tab, choose TCP/IP from the drop-down 
list to select the Type of communication. This drop down contains all of the 
available Device types. 
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DETAILS TAB  

Device  

Name This is a logical name utilized by the administrator to refer to 
this physical device. For example a Video Server may be called 
VIDEO_SERVER1 

State Default value is set to Enabled 

Communications 

Type This drop-down contains all available Device types, but will be 

TCP/IP for a Video Server. 

Reconnect 

Interval 

When the Device loses connection with the boards, it will try 

to reconnect every second which can cause excessive network 
traffic. This field allows you to set your own rate in seconds. 
Default is set to 5 second intervals. 

Host Enter Host or IP address of the video server's connection 
point. This must match what is configured in the Configuration 
Editor. 

Port The port used to connect to the terminal server or LAN. 

Once all of the fields are populated, click Save and the TCP/IP Device will appear 

under the devices folder. 
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Sample Video Server Device set up in Marquee Manager Administrator: 
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Adding a New Marquee 

The following are basic steps to follow in configuring marquees; more details are 

provided in the Section entitled “Configuring Key Components – Marquee Details” in the 
Marquee Manager Server V9 manual.   

New Marquee Steps 

1. Expand the Devices folder. Under any Device, select the Marquees folder under the 
new VideoServer device that was just created. Right click and select New - 
Marquee or select the Marquees folder and click the New button on the toolbar.  
 

 
 

You can also click on the Marquee folder located directly under the Device folder 
and choose New from the toolbar. The first tab that appears is the Details tab. 
  

DETAILS TAB  

Marquee 

Name Enter the Marquee Name and Description. The name will 
appear in Marquee Manager Client and gateways 

exactly as it is typed in this field. 

Description Enter a description of the marquee. This field is 
optional. 

Device If you are adding a marquee under the Device folder, 

the Device name will already be filled in. If you are 

adding a marquee from the Marquee folder, you must 
choose a Device from the drop-down list. 

State The state can be Enabled (default), Disabled or Test 
mode. This allows you to disable or enable individual 
marquees to make firmware changes or for testing 
purposes. The state of Test is the marquee's 
manufacturer's specific default settings which can be 

used to determine if the marquee is fully functional. 
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Type 

Manufacturer The drop-down list contains supported 
manufacturers. 

Model This drop-down contains the Models specific to your 

Manufacturer choice.  The selection here must 
match what is configured in the Video Server. 

Settings 

Address Each manufacturer will have a different address 

format. For format examples, see the Appendix on 
Manufacturer Address Format.  This must match 
the address that is configured in the Video Server 
Configuration Editor. 

2. Once you have Saved, you will see two buttons listed under Marquee Functions.  

Clear: Allows the marquee to be cleared of all messages, including those sent 

through Marquee Manager Client. 

 

Refresh: Allows the marquee to be refreshed, maintaining all current 
messages that are currently displayed or in the queue to be displayed. 

3. To view all of your marquees, you can click on the Marquee folder in the tree 

view and a list will be displayed in the right pane. 

 

 

 
 



Using the Video Server 

Page 31 of 38 

 

4. There are several manufacturers and types of marquees. For each type, there are 
specific set-up instructions and options. The types covered are: 

 Bin Cell   Speaker  

 Clock Display  Stack Light 

 ColorBlock   Text Cell 

 Controller  Text Display 

 Counter  Tune Device 

 Marquee  Web Display 

 Solid Cell  

 

5. Once you have chosen a marquee, you can begin configuring the rest of the 
tabs. The available tabs will vary, depending on which Manufacturer and Model 
of marquee you choose.  

6. At least one marquee configured must be a model type of Controller.  This 
controls the templates that will be displayed on the displays. 

For detailed steps on adding the various types of marquees, please see 

“Chapter Three – Configuration” in the Marquee Manager Administrator v9.0 
manual.  The sections entitled “Configuring Key Components – Marquee 
Options” and “Configuring Marquees By Type” provide details on what options 

are available for each marquee as well as steps required to configure each type 
of marquee. 
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Sample Controller marquee set up in Marquee Manager Administrator 

 

 

7. Also be sure that options such as Line Count, Number of Columns and Number 
of Rows on the Options tab match what is configured in the Video Server 
Configuration Editor.   
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Glossary 

Administrator 

Typically a GUI application, this component facilitates configuration and monitoring of a 

server engine. If changes are made to the server configuration the administrator 
notifies the engine to reload its running configuration either automatically or on user 
demand. An example of an administrator component is FirstPAGE Administrator. 

This administrator allows you to maintain the FirstPAGE server's engine configuration.  

Administrator Kit 

An administrator kit contains the product's administration component only. After 
installing this kit on a workstation you may utilize any of the features of the 
Administrator component. 

Andon 

Andon boards are used to show where (station or location) there is a problem (fault) or 
a potential problem (blocked or starved station or low on stock). They are used to alert 
the proper personnel that something needs their attention - either immediate or in the 

near future. A marquee may be used to give mention to upcoming meetings, or events 
and can display the time, date, number of parts that are expected and actually 
produced. Basically, they are a visual communication tool used to help production meet 
their goals and minimize shut down time. 

Bin 

An area within each cell that contains data relevant to various locations in an 

environment. (i.e. plant stations such as paint) and various statuses typically used in 
these areas. Data such as current station state or a station that may be experiencing a 

problem may be displayed on the Andon Board.   

Cell 

For Andon type marquee signs, a cell refers to one block of data on the sign. 

Device 

A Marquee Manager Server device is a name assigned to a physical connection point on 

the server, which will be used to establish a connection with a marquee. 

Marquee 

A sign display that serves as a visualization communication tool, providing the means to 
display time, date and message text such as production counts, and what areas of a 
plant are experiencing problems. 
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Appendix A - Manufacturers Address Formats 

Manufacturer Address Format 

Adaptive Alpha Version 2 2-digit hex from the display   
Range = 00-FF 

e.g. 01 

Adaptive Micro Systems 2-digit hex from the display 
Range = 00-FF 

e.g. 0A 

Allen-Bradley Inview 2-digit hex from the display 
Range = 00-FF 

e.g. 0C 

Electro-Matic Products Inc. Stack Light & Sounder: 

group:unit hex 

Range = 00-FF for group and unit 
4-digit display: 
2-digit hex from the display 
Range = 00-FF 
e.g. 03 

NETCON Technologies Native Unit Fixed length 4-character address field. 
First two bytes represent group, second 
two bytes represent unit. Valid values 
00-FF. All characters in uppercase. 

e.g. 01:EF 

Nu-Media Display Systems 8-bit addressing where group = 0 
2-digit hex value 

e.g. 01 

Static Controls Corporation group:unit hex 

Range = 00-FF for group and unit 

e.g. 01:FF 

Uticor Technology group:unit with 00:0000 format 

e.g. 00:0003 

 

You may use the number zero as a wildcard character when searching for an unknown 
address. e.g. 01 will return all addresses with two digits where the last digit is 1. 
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Appendix B – Insertion Tags 

Tag Description Attributes available 
   

COL Color AMB – Amber 
  BLK – Black 
  BLU – Blue 
  BRN – Brown 
  DEF – Default 

  GRN – Green 
  LGR – Light green 
  ORG – Orange 
  RED – Red 
  LRD – Light Red 

  WHI – White 
  YLW - Yellow 

   

BCL Background color Same as COL 

FNT Font DEF – Default 
  SML – Small 

JST Justification CEN – Center 
  DEF – Default 
  LEFT 
  RIGHT 

MOD Mode DEF – Default 

  FFL – Fast flash 
  FL – Flash 
  REV – Reverse 
  RFF – Reverse fast flash 
  RFL – Reverse flash 

  ST – Static 

  STR – Strobe 
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Appendix C – Object Usage 

Graphical Objects 

Supported file types for image files are JPEG, GIF, BMP and PNG.  

Timer Object 

For the timer object to function, packets must be passed to it in the following 

format: DateTime~<attributes>StartTime~<attributes>LabelText"~<attributes> 

Threshold~<attributes>LabelText~<attributes>EndTime~<attributes>LabelText
~ 

Example packets: 2012/04/21 01:47:08~<COL-WHI><BCL-DEF><MOD-

DEF>0~<COL-WHI><BCL-DEF><MOD-DEF><SCR-DEF>Elapsed Time~<COL-

YLW><BCL-DEF><MOD-DEF>60~<COL-YLW><BCL-DEF><MOD-FL><SCR-

DEF>Time Warning~<COL-RED><BCL-DEF><MOD-FFL>120~<COL-RED><BCL-
DEF><MOD-FFL><SCR-DEF>OVER TIME~ 

Packet Description 

DateTime Date and time to begin the timer in the 

format YYYY/MM/DD HH:MM:SS 

StartTime Value to begin counting from. If this 
value is less than EndTime, the timer 

will count up. If this value is greater 
than EndTime, the timer will count 
down. 

Threshold Time at which to change the label and 
attributes to display another value such 
as a time warning. 

EndTime Time at which to stop counting. Label 
and attributes can be changed again to 
reflect an expired state. 

LabelText The text to be displayed at each of the 
Start, Threshold and End intervals of 
the timer. 

Attributes Display attributes of the data to be 
displayed. Multiple attributes can be 
assigned. 
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String Alert 

For the timer object to function, packets must be passed to it in the following 

format: <attributes>Text~<attributes>Message 

~<attributes>DateTime~Threshold~ 

Example packets: <BCL-RED><COL-YLW><JST-CEN><TIME-24>OP10~<BCL-

DEF> <COL-RED>Torque tool <MOD-RFF><BCL-RED>fault @ K12 ~<JST-
RIGHT>2012/06/29 15:23:45~300~ 

This control supports displaying multiple rows of data. In order to enable this, the 

“Remote Queue” function of the corresponding marquee in Marquee Manager 

must be enabled. 

 

Packet Description 

Text  Static text which will not change, such 
as a station number. 

Message Dynamic, changing text to indicate an 
alert or data to display. 

DateTime Date and time to begin the timer in the 
format YYYY/MM/DD HH:MM:SS 

Threshold Time at which to change the label and 
attributes to display another value such 
as a time warning. 

Attributes Display attributes of the data to be 
displayed. Multiple attributes can be 
assigned. 
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Appendix D – Additional Settings 

Registry Settings 

Additional settings for the Video Server Emulator can be accessed and modified via the 
Windows registry. On a 32-bit OS, these keys can be found in the following locations: 

32-bit OS:  
HKEY_LOCAL_MACHINE\SOFTWARE\ \SEQENT\VideoServer\Emulator\Config 

64-bit OS: 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SEQENT\VideoServer\Emulator\Config 

Key Name Values Description 

AlwaysOnTop Binary (0,1) Keep the emulator window on top of 
all other windows. 

FullScreen Binary (0,1) Run the emulator in full-screen 
mode. Running in this mode will also 
hide the mouse cursor. 

Font List Configuration 

The list of fonts available for selection in the configuration editor can be modified 

using the FONTS.xml file located in the EXE subdirectory of the configuration 
editor install directory. 


